	Desarrollo de Páginas WWW


	MS FRONT PAGE


	Objectivos

	Al terminar este tópico, usted será capaz de:
1. Explicar qué son páginas Web.
	


CONSIDERACIONES GENERALES
	¿Qué es una Página Web?


Una página Web es un archivo que emplea el Lenguaje de Etiquetación de Hipertexto (HyperText Markup Language, o HTML).  Esta es una herramienta, o lenguaje, utilizada para crear archivos de texto que se conectan a otras páginas o documentos externos por medio de hipertexto.  Comúnmente, una página Web posee la extensión de archivo .htm o .html.  Una sola página Web puede estar compuesta de varios elementos u objetos, tales como un Título presentado en la barra superior de la ventana del navegador, un Encabezado (Header) exhibido en negritas al principio de la página y de un tamaño grande, el Texto Nomal que posee el contenido, una Firma en la región inferior de la página, Reglas o Líneas Horizontales empleadas para separar/dividir secciones lógicas dentro una misma página, elementos multimedios (Ej., imágenes, videos, audio), enlaces o hipervínculos, mapas de imágenes, Listados (Ej: bullets), Formularios y otros posibles componentes.  Por otro lado, un Visualizado Gráfico o Navegador de Páginas Web es una aplicación de cliente gráfico, activada en la computadora del usuario, encargado de bajar/exhibir e interpretar los códigos (Ej: archivos etiquetados) que posee una página Web desde un programa instalado en un servidor Web conectado al "World Wide Web" (WWW, Web, o W3) o a la intranet de una compañía.  Consecuentemente, el navegador del Web permite el acceso a las páginas de información que ofrecen los servidores del WWW.  Los servidores Web son aquellos sistemas de computadoras en conexión con la Internet que poseen los documentos o páginas de información escritos en el formato de HTML.  El acceso a las páginas Web pueden efectuarse por medio de la dirección WWW que disponen los servidores del Web, es decir, a través del formato URL (Uniform Resource Locators), el cual sirve de guía para hacer la conexión a la página del servidor Web.  El formato URL se divide en tres secciones.  La primera nos indica el tipo de servidor WWW que empleamos.  Por ejemplo, en un URL como: http://www.saludmed.com//index.html, la parte http nos indica que se emplea un servidor del WEB.  La segunda porción del URL (www.saludmed.com) muestra el dominio (domain) de la computadora.  La tercera parte (/índex.html) señala la localización específica (es decir, el directorio) del archivo en el servidor Web.
	¿Qué es MS Front Page?


MS Front Page representa un programa de autoría designado específicamente para el desarrollo de páginas Web.  Un programa de autoría para el Web (Web authoring software) te asiste en crear páginas Web al escribir de forma automática el código mientras el usuario solamente se encarga de escribir el texto e insertar elementos multimedios en la página.  Este programa permite crear, publicar y editar páginas HTML, las cuales, una vez publicadas en un servidor Web, se podrán ver en un navegador para el Web, tal como “MS Internet Explorer”.
Front Page provee una solución completa para crear, manejar y publicar sitios Web.  También dispone de un editor de páginas Web, donde se integra un conjunto de herramientas que permite construir y manejar en su totalidad un sitio Web en la Internet.
Una de las herramientas fundamentales de MS Front Page es el uso de plantillas (templates) o el mago (wizard).  Cada plantilla o mago  crea un conjunto de páginas Web coordinadas e interlazadas para un propósito particular, tal como un curso o adiestramiento interactivo multimedio en línea, foros. de discusiones, exhibir información personal (Ej: un resumé), un sito Web de comercio electrónico (e-commerce), manejar un proyecto de grupo o colaborar con tu grupo de trabajo en un sitio Web que se encuentra basado en los Servicios de Compartir de Microsoft (Microsoft Windows SharePoint Services).  la plantilla o mago formatea las páginas de forma consistente y añade barras de enlaces (links), imágenes, texto y otros elementos iniciales fundamentales para el desarrollo completo de un lugar interactivo en la Internet/Web.  Otras plantillas de MS Front Page, conocidas como paquetes (packages), sirven para crear sitios Web basados en datos en un servidor Web corriendo “Windows SharePoint Services”.  Estos tipos de páginas incluyen sitios para rastrear problemas, un sitio para noticias y resúmenes de productos o un “Web log” (blog).
Además, este programa permite abrir y editar un sitio Web directamente en un servidor WWW.  También, es posible trabajar, desconectado de la Internet, una copia del sitio Web desde una fuente de almacenamiento local (Ej: unidad de disco duro) o desde una red, y luego publicarlo a un servidor Web.  Para estos propósitos, se puede emplear la vista de Sitio Web Remoto (Remote Web Site view) para copiar y sincronizar archivos entre un sitio WWW local y otro remoto.
La interactividad y la inclusión de multimedios en páginas HTML es una de las características atractivas que posee Front Page.  En estas líneas, este programa de autoría para el desarrollo de páginas WWW permite añadir y formatear texto, símbolos, imágenes, archivos de animación (Ej: Shockwave Flash, animaciones GIF), segmentos de video, líneas divisoras horizontales, hipervínculos, tablas, formularios, marcos y otros elementos estándares característicos de un sitio Web.  Más aún, MS Fron Page permite añadir componentes para páginas Web, tales como estampas de fecha y hora, comentarios, efectos dinámicos (Ej: botones interactivos), formularios para realizar búsquedas en las páginas creadas, hojas de cálculo o gráficas, contadores de visitantes (hit counters), galería de fotos, archivos incluidos, barras de enlaces, tablas de contenido, estadísticas para uso del sitio y controles que exhiben información de sitios Web (Ej: MSN o Expedia).
Otras herramientas útiles de Front Page incluyen añadir programitas de Java (Java Applets), controles ActiveX y otros controles avanzados para páginas WWW.  También, se puede adjuntar una página a una plantilla dinámica (dynamic templates), la cual provee contenido y formateo, restringe las áreas donde la página puede ser modificada y mantiene a ésta actualizada con modificaciones en sus plantillas.
PRINCIPIOS GENERALES PARA LA 
ELABORACIÓN DE PÁGINAS WWW

El montaje completo y efectivo de un sitio Web, incluyendo todas su páginas constituyentes, requiere una planificación cuidadosa del proyecto.  Este proceso consiste en planificar conceptualmente el proyecto, un análisis de necesidades, definir la audiencia o población de tales páginas, los propósitos del trabajo, sus objetivos, los recursos de equipo y de programación (software) requeridos, las políticas para el desarrollo y uso de su información, el desarrollo de su diseño y prototipo, el tiempo que tomará en construir el sitio Web, su validación, el mercadeo del sitio Web y el mantenimiento y actualización de la páginas.
El desarrollador deberá decidir cuál será el nombre de su dominio y determinar si está disponible.  En otras palabras, éste será su dirección del Web o el URL.  Localmente, es recomendable crear una carpeta que sea equivalente al nombre de su dominio.  Dentro de este directorio se trabajarán las páginas para el sitio Web.
Es crucial confeccionar un diagrama de flujo que organice las páginas y sus enlaces, y un prototipo del diseño o interfaz de las páginas.  Una vez construido las páginas localmente, hay que comprobar opere efectivamente todos sus elementos integrantes.  Si todo trabaja bien, el próximo paso sería publicar las páginas creadas al servidor Web, comúnmente mediante FTP (File Transfer Protocol o Protocolo de Transferencias de Archivos).
Además, al inicial la planificación del trabajo, se debe se considerar las metas que se desean lograr por medio del sitio Web creado.  Las páginas desarrolladas deben poseer un mensaje impactante para la audiencia que se intenta alcanzar.  Por lo tanto, es imperante primero analizar las metas que se esperan alcanzar, las características, actitudes y preferencias de la audiencia (Ej: los estudiantes) y el contenido.  Reflexione sobre lo siguiente: ¿dónde quieres que tú presentación del Web se vea?, ¿hay gente en el Web que quiere verla, ¿Quiénes son?, ¿Qué quieren ver? ¿A quién quieren ver?.  Pregúntate, porque estas colocando una presentación en el Web en primer lugar, y para quien.  Diseña tu presentación con estas metas y los lectores potenciales. En resumen, tenemos que la planificación del proyecto para la construcción de las páginas WWW involucra lo siguiente:
(
Preparación de maestro.  Esta fase inicial se refiere a la adquisición de conocimientos sobre las destrezas requeridas para crear y editar páginas efectivas en el Web

(
Desarrollo del concepto (definir el proyecto).  La segunda fase para el desarrollo de un sitio Web es recopilar y analizar la información requerida (literatura/contenido).

(
Inventario de recursos de equipo, programación y presupuesto.  Aqui se requiere llevar a cabo un proceso de investigación/búsqueda por recursos necesarios para la construcción de las páginas WWW. 

(
Análisis o estudio de necesidades.  Esto incluye el establecimiento de metas generales alcanzables para el Web, establecer el alcance, propósito y objetivo del proyecto.  Además, es necesario definir la audiencia que navegarán las páginas WWW a ser creadas. para un sitio Web funcional y efectiva, es crucial comprender las capacidades de los usuario o clientes que navegarán en las páginas.  En esta fase, también se establece la producción de las metras instruccionales.
(
Diseño de las páginas.  Se  refiere a la estructura visual de los elementos y organización de las páginas WWW, tales como el prototipo (stroryboard) o la interfaz o sistemas de navegación primarios y secundarios, los hipervínculos, aspectos decorativos (Ej: imágenes), texto, nombres y etiquetas.  También, en esta fase se establecen de estrategias curriculares y pedagógicas que requiere un sitio Web educativo.  Antes de todo, el desarrollador debe crear un mapa conceptual del sitio Web, donde  se ilustre la organización de las páginas.  Un mapa del sitio representa una estructura visual/diagramática de todo el proyecto, donde ensamblan/organizan las páginas, se definen su flujo de comunicación o enlaces y la posición estratégica del sitio.

(
Logística. Este es el proceso administrativo que organiza y selecciona los recursos requeridos.  Es la fase donde se reúnen todos los constituyentes del proyecto, de manera que se pongan a trabajar.  Además, en el plan de trabajo debe establecerse un calendario detallado defina la distribución del tiempo y sus tareas correspondientes, de manera que se pueda terminar el proyecto en el pazo proyectado.

(
Desarrollo de políticas.  Esto consiste en formular políticas/guías o normas con referente al desarrollo de la información, despliegue, y presentación que pueda servir de guía para otros interesados en desarrollar páginas del Web parecidas.
(
La evaluación y a validación completa del sitio Web.  Es imperante realizar controles de calidad, de modo que se diagnostiquen y corrijan los errores.  Un control de calidad cosiste en una comprobación exhaustiva del sitio para detectar posibles fallas en comparación con las especificaciones originales.  Es simplemente comprobar que funcione el sistema de navegación y los hipertextos/hipervínculos de las páginas que componen el sitio Web.  Evalúa las páginas WWW creadas en su sitio Web de la misma manera que se espera que los usuarios la accedan.  Coteje todos los enlaces internos y externos y los hipervínculos con archivos externos.
(
Lanzamiento y mercadeo del proyecto.  Una vez que haya pasado por el proceso riguroso de validar el sitio Web, se procede a promocionar o establecer estrategias /campañas para anuncia que el sitio Web es operativo.

(
Mantenimiento y actualización las páginas.  Esto consiste en recopilar y mantener la información pertinente que apoyará el Web.   En esta última, pero importante fase se requiere actualizar el contenido, la estructura visual de las páginas y sus códigos (Ej: HTML, Java y otros).
EJERCICIOS DE PRÁCTICA

	Desarrollo de un Portafolio Digital


	Subir el Programa de MS FrontPage


1.
Desde "Start", seleccione "All Programs", abrir el directorio de “Microsoft Office” y haga clic sobre "Microsoft Office Front Page":
Clic: Start→Seleccionar: All Programs→Carpet de: Microsoft Office→ Clic: Microsoft Office FrontPage 2003
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	Crear la Primera Página del Portafolio:


1.
Primeramente, comenzaremos creando una página en blanco.  Desde la Barra de Heramientas Estándar, dé un clic al icono que ilustra una pagina en blanco ([image: image3.bmp]), la cual posee un texto alternado llamado: Create a new normal page.
Desde: Menú de Herramientas Estándar→Clic: [image: image4.bmp]
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Esto abre el Panel de Tareas ubicado en la zona izquierda de la ventana de Front Page, la cual está titulada como “Layout Tables and Cells”
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2.
Para asegurarnos que no se pierda el trabajo en el caso de un cambio de voltaje eléctrico, guarde la página dentro de su carpeta de MS FrontPage.  Diríjase al menú de barra, haga clic sobre “File” y, desde el menú contextual, seleccione "Save As".
Desde: Menú de Barra→Clic: File→Seleccione: Save As
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En estos momentos, deberá observarse la caja de diálogo o ventana titulada: "Save As".  Navegue hacia el lugar donde se habrá de guardar el archivo.  Para esto, desde la sección rotulada “Save in”, haga clic a la flechita ([image: image9.bmp]) y, desde el menú contextual, busque la letra de su “Flash Drive” y navegue hacia la carpeta de su portafolio digital donde se encuentre “MS_FrontPage”.  En el encasillado rotulado “File name”, donde tiene de manera predeterminada index.htm, cambie este nombre por su nombre y, a continuación, aplique un clic sobre el botón de “Save”.
Desde Dialog Box: Save As→Ir a Sección: Save In→Clic [image: image10.bmp]→Seleccione Letra y Carpeta de su Portafolio Digital→Ir a: File Name→Escriba su Nomre→Clic: [image: image11.png]
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3.
Ahora, vamos a crear una tabla usando uno de los diseños predeterminados.  Desde el panel de “Layout Tables and Cells”, diríjase a la sección rotulada como “Tabla Layout” y haga clic sobre la segunda alternativa (Full Page).
Desde Panel: Layout Tables and Cells→Ir a Sección: Table Layout→Clic Segunda Opción: Full Page
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4.
Cambie las dimensiones de la tabla.  Desde el panel de “Layout Tables and Cells”, diríjase a la sección rotulada como “Table Properties”.  Nótese que de forma predeterminada (default), la tabla posee un ancho (Witdth) de 1055 y un alto (Height) 576.  Seleccione la cajita de cotejo rotulada “Auto-scale cells with table”.  Luego, haga clic dentro del encasillado del ancho (Width) y escriba 650, y en la altura (Height) 650.  Finalmente, desde las propiedades de la tabla, dirigirse a la sección rotulada como “Alignment”, seleccione center ([image: image15.bmp]).
Desde Panel: Layout Tables and Cells→Ir a Sección: Table Properties→ Clic Encasillado de Cotejo: [image: image16.png]Auto-scale cells with table



→Clic Encasillado: Width→Escriba: 650→Clic Encasillado: Height→Escriba: 650→ Ir a: [image: image17.png]Alignment:



→Clic: [image: image18.bmp]
	[image: image19.png]Table properties

width: 1055 (1055)
Heght: (575 | (575)

Algrment;

[ Auto-scale cells with table:
Set Page Margins,




	[image: image20.png]%ﬁuta—sca\e cells with table
58% Page Margins.




	[image: image21.png]Table properties

width: (650 | (60
Height: (650 | (650)

Algrment;

Auto-scale cells with table

et Page Margins,






	[image: image22.png]Algrment;

o cols i

Algn Center

Set Page Marains.






Nótese que en la Vista de Diseño (Design View) aparece el marco de la tabla con sus configuraciones previamente establecidas.
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5.
Vamos ahora darle un color a la tabla.  Seleccione los bordes de ésta y, desde la Barra de Herramientas de Formatear, haga clic sobre la flechita del icono que posee el texto alternado de “highlight” ([image: image24.png]


). A continuación, bajo la ventana de “More Colors”, escoja un color amarillo claro.
Desde Panel: Barra de Herramientas de Formatear→Clic Botón de Highlight: [image: image25.png]


 Clic More Colors→Desde Ventana de: More Colors →Seleccione: Amarillo Claro.
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6.
Lo próximo que haremos es insertar una capa (layer) en la región superior de la tabla.  Desde la Barra de Herramientas Estándar, haga clic sobre el icono de “Insert Layer” ([image: image29.bmp]).  Automáticamente, se colocará un capa en la esquina superior izquierda de la tabla.  Posicione el punyero del ratón sobr la agarradera de la derecha medial del la capa.  En estos momentos, el puntero del ratón deberá convertirse en una doble flecha ([image: image30.bmp]).  Presione el botón izquierdo del ratón y arrastre la capa, de manera que se extienda hasta el extremo derecho de éste.
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